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Preface

This reference guide describes the features of Oracle Transfer Pricing Online (also 
known as Transfer Pricing Online or TPOL). 

The preface contains the following information about the reference guide:

■ Intended audience

■ Organization

■ Related documents

■ Conventions

■ Customer support information

Intended Audience
Transfer Pricing Online is designed for use by finance professionals within the 
financial services industry. Therefore, this guide assumes that you are familiar with 
terms and concepts related to transfer pricing. It also assumes that you have access 
to TPOL (in other words, that you have the appropriate URL, user name, and 
password), and to Oracle Transfer Pricing.

Organization
The reference guide is organized into the following chapters, including an 
appendix:

Chapter 1 Introduction

Chapter 2 System Configuration
ix



There is also an index.

Related Documents
For more information about transfer pricing, refer to the Oracle Transfer Pricing 
Reference Guide.

For more information about interest rates, refer to the Oracle Rate Manager Reference 
Guide.

For information about installing and configuring Transfer Pricing Online, see the 
Oracle Financial Data Manager Installation and Configuration Guide. 

If you have installed other Oracle Financial Services (OFS) applications, refer to 
their reference guides.

For information about the Oracle Financial Data Manager database, which supports 
Transfer Pricing Online and all other OFS applications, refer to these publications:

■ Oracle Financial Data Manager Administration Guide

■ Oracle Financial Data Manager Data Dictionary

■ Oracle Financial Services Technical Reference Manual

Conventions
The following conventions are used throughout this book:

Chapter 3 Products

Chapter 4 Scheduler

Chapter 5 Queries

Chapter 6 Worksheets

Appendix A Error Messages

Convention Meaning

    .
    .
    .

Vertical ellipsis points in an example mean that information not 
directly related to the example has been omitted.

. . . Horizontal ellipsis points in statements or commands mean that 
parts of the statement or command not directly related to the 
example have been omitted.
x



Symbols
■ Bullets indicate a list of items or topics.

1. Numbered lists are used for sequential steps in completing a procedure.

Orientation of Procedures
Procedures in Oracle Financial Services Applications (OFSA) reference guides are 
generally driven by menus rather than by commands or icons. Only occasionally is 
a reference to a toolbar or mouse action necessary because the action has no menu 
equivalent. If you prefer to use the toolbar icons, refer to Chapter 1, "Introduction". 
You can also use the right mouse button to display many of the drop-down menu or 
icon driven options.

Notes, Cautions, and Warnings
Certain information is emphasized by appearing in a box labeled Note or Caution.

■ Note refers to interesting but incidental information about the product, or 
information that is important but less so than a Caution or Warning.

■ Caution indicates the possibility of damage to a product, system, or data.

boldface text Boldface type in text indicates a term defined in the text, the glossary, 
or in both locations. 

bold monospace Bold monospace type in text indicates information that you type in.

Italics Italics emphasize a word or phrase.

< >  Angle brackets enclose user-supplied names (for example, <Branch 
Name>).

[ ] Brackets enclose function and terminal keys. In common syntax, 
brackets denote one or more optional items.

{ } Braces are used to denote variables, and in command syntax, a choice 
within a mandatory item.

Example of command syntax: 

Warning: INIT file {filename} already exists.

Example of choices: 

{EXIT|QUIT}

 > This arrow indicates a menu path.

Convention Meaning
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Product Support 
Product support is available through Oracle Support Services. Contact your project 
manager for information about using the support options offered in your 
geographic region. These options may include the following:

■ MetaLink (which provides online access to information about Technical 
Libraries, Patches, TARs, and Bugs and is available at metalink.oracle.com)

■ Telephone support
xii
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Introduction

Transfer Pricing Online, or TPOL, is an interactive Web-based application that 
provides real-time transfer rate indications in support of pricing loan transactions. It 
addresses the need for lending personnel in the field to quickly and reliably 
measure transaction profitability.

Through a Web browser, TPOL users can access current-day transfer rate 
indications for predefined standard products using the Queries function. They can 
also calculate, on a real-time basis, transfer rates based on specification of 
instrument cash flow and payment characteristics using the Worksheets function.

TPOL methodologies are tightly integrated with the transfer pricing methodology 
and prepayment assumptions used in Oracle Transfer Pricing. Also, TPOL uses 
current interest rate and transfer rate data maintained through Oracle Financial 
Data Manager Rate Manager (commonly referred to as Rate Manager). 

Logging In
To log in to TPOL, first open your Web browser. Then, using an appropriate URL 
(supplied by your system administrator), connect to TPOL and the database. 

Main User Interface
The user interface supports two types of users: administrators and end users. The 
administrative functions are available only to users with administrative privileges. 
A function-specific security feature is available, enabling you to assign partial 
administrative or end-user privileges (or both) to any user.
uction 1-1



Main User Interface
Menus
You can select Transfer Pricing Online options through the menus or the toolbar 
icons. The following is a description of the menus and their options:

File Menu
File menu options enable you to create, save, and delete queries and worksheets, 
and to exit TPOL.

New  Select New Query to create a query or New Worksheet to create a worksheet.

Delete  Select Delete to delete an open query or worksheet. A message appears, ask-
ing you to confirm that you want to proceed. When you click Yes, TPOL deletes the 
item and displays a message confirming the deletion.

Save  Select Save to save queries and worksheets as you create or modify them. 
TPOL confirms that the item has been saved.

Exit  Select Exit to exit TPOL.

Edit Menu
Edit menu options enable you to modify system configuration settings and the 
System Configuration Product List. 

Tools Menu
The Tools menu enables you to run an open query or worksheet, and to schedule 
the running of transfer rate calculations for standard products. You can schedule 
calculations to run automatically at certain intervals, or to run only once at a 
specific time.

Help Menu
Use the Help menu to access different help options. 
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Main User Interface
Toolbars
The horizontal toolbar contains a set of icons, which are preset and cannot be 
customized. Following the illustration is a brief description of each icon.

Pop-Up Descriptions and the Status Bar
When you place the cursor on a toolbar icon, a window field, or a window button, 
TPOL displays a brief description of the item. In addition, the icon description 
appears in the status bar, which is located at the bottom of the TPOL interface. The 
status bar also displays the record number of any product record that you view. 

Icon Name

1 New Query

2 New Worksheet

3 Delete

4 Save

5 Exit

6 System Configuration Settings

7 System Configuration Product List

8 Run

9 Schedule

10 Expand All

11 Collapse All

3 51 9 11

2 4 6 8 10

7
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System Configuration

There are two System Configuration options, which are available only to authorized 
administrators. One option enables you to choose configuration settings for specifying 
transfer pricing assumptions and methodologies. The other option enables you to select a set 
of standard products for scheduled (daily) transfer pricing.

System Configuration settings use assumptions defined in Oracle Transfer Pricing to run 
scheduled transfer pricing calculations and provide default methodologies for transfer- 
pricing customized accounts in real time.

As an administrator, you can access and assign the Transfer Pricing IDs and the Prepayment 
IDs, defined in Oracle Transfer Pricing, to transfer-price standard sets of products that will 
have calculated transfer rates available for querying. Also, you can specify Transfer Pricing 
methodologies for transfer-pricing nonstandard loans.

System Configuration Settings
From the System Configuration Setting window, select the following parameters: 

n Product Dimension

n Transfer Pricing ID

n Prepayment ID

n Default Transfer Pricing Interest Rate Code

n Default Transfer Pricing Method
ration 2-1



System Configuration Settings
Each of the five setting options in the System Configuration Settings window has a 
drop-down menu. 

Select the configuration setting you want from each drop-down menu, then click Ok to save 
your settings.
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System Configuration Settings
Setting Definitions
An explanation of each of the settings follows.

Setting Description

Product Dimension The product dimension is the chart of accounts used throughout the 
system. It controls the listing of products and thus controls all other 
data stored and used within TPOL, except data related to worksheets.

The drop-down list from which you choose product dimensions consist 
of all product leaves defined in the system.

If, under unusual circumstances, you must change the product 
dimension, you must also reset the configuration settings for the 
Transfer Pricing ID, Prepayment ID, and the Product List.   

When you change a product dimension, users no longer have access to 
queries created under the product dimension used prior to the change. 
To access queries created under a previous dimension, you must restore 
the original dimension. 

This selection eventually determines the set of products available to 
end users when running queries, once the system precalculates the 
transfer rates.

Transfer Pricing ID This drop-down list contains all Transfer Pricing IDs in folders to 
which you have access. These IDs are created using Oracle Transfer 
Pricing, and are stored in the database. 

The product dimension chosen determines the list of available Transfer 
Pricing IDs. When the product dimension changes, the list of available 
Transfer Pricing IDs also changes. 

The system accesses this setting when running scheduled transfer 
pricing calculations.

For more information on Transfer Pricing IDs, refer to the “Transfer 
Pricing ID” chapter in the Oracle Transfer Pricing Reference Guide.
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System Configuration Settings
Defining Configuration Settings for Queries and Worksheets
The System Configuration Settings window appears when you log in to TPOL for the first 
time. You must define a product dimension and Transfer Pricing ID before you can use other 
functions. All of the scheduled calculations that TPOL performs are based on the product 
dimension, Transfer Pricing ID, and Prepayment ID that you select. Worksheets use the 
default selections specified for Transfer Pricing Interest Rate Code and Transfer Pricing 
Method.

Prepayment ID This drop-down list contains Prepayment IDs that were created in 
Transfer Pricing. They are stored in the database, in folders to which 
you have access. 

Selecting a prepayment ID is optional, unlike a Transfer Pricing ID. 
The Prepayment ID default selection is <None>. 

The product dimension chosen determines the list of available 
Prepayment IDs. When the product dimension changes, the list of 
available Prepayment IDs also changes. 

The system accesses this setting when running scheduled transfer 
pricing calculations.

For more information on Prepayment IDs, refer to the “Prepayment 
ID” chapter in the Oracle Transfer Pricing Reference Guide.

Default Transfer Pricing 
Interest Rate Code

The drop-down list contains an alphabetized list of interest rate codes 
defined in the database. 

The system accesses this setting when running worksheets.

For more information on Interest Rate Codes, refer to the Oracle 
Transfer Pricing Reference Guide and the Oracle Rate Manager 
Reference Guide.

Default Transfer Pricing 
Method

The drop-down list contains the following methods: 

n Cash Flow Weighted Term

n Cash Flow Duration

n Straight Term 

n Cash Flow Zero Discount Factor

The default option is Cash Flow Weighted Term.

The system accesses this setting when running worksheets.

For more information on methods, refer to the "Transfer Pricing 
Methods" chapter in the Oracle Transfer Pricing Reference Guide.

Setting Description
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System Configuration Settings
Defining Configuration Settings
To define configuration settings, complete the following steps:

1. From the Edit menu, choose System Configuration Settings. The System Configuration 
Settings window appears.

2. From the drop-down list, choose a Product Dimension. 

3. From the drop-down list, choose a Transfer Pricing ID. 

4. From the drop-down list, choose a Prepayment ID. (This is an optional setting.)

5. From the drop-down list, choose a Default Transfer Pricing Interest Rate Code. 

6. From the drop-down list, choose a Default Transfer Pricing Method. 

7. Click Ok to save the settings, or click Cancel to cancel the entire operation. 

Changing a Product Dimension
Whenever you change a product dimension, this message appears: 

Changing the Product Dimension will effect the rest of the system. All other System 
Configurations settings must be reset.

Are you sure you want to continue? 

Click Yes to save the product dimension change, or No to cancel the action.
System Configuration 2-5



System Configuration Product List
System Configuration Product List
The system configuration product list consists of all product dimension values defined in 
Transfer Pricing, under the chosen product dimension. When you open the System 
Configuration Product List window, a column of available products and a column of selected 
products appears, as shown in the illustration.

To move one or more products to the opposite column, click an arrow button in the window:

Note: When you open the System Configuration Product List for the 
first time, the Selected Products column is empty.

Button Function

Right arrow (>) Moves a product from the Available Products list to the Selected 
Products list

Double right arrow (>>) Moves all products from the Available Products list to the 
Selected Products list

Left arrow (<) Removes a product from the Selected Products list and places it in 
the Available Products list
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System Configuration Product List
Creating System Configuration Product Lists
Create a product list by moving one or more products from the Available Products list to the 
Selected Products list:

1. Select Edit > System Configuration Product List. The System Configuration Product 
List window appears.

2. From the Available Products list, select a product to move to the Selected Products list.

3. Click the right arrow (>) to move the product. 

To move all products, click the double right arrow (>>). To move one product at a time, 
repeat steps 2 and 3.

4. Click Ok to complete the changes. 

The message System Configuration Settings have been saved appears.

5. Click Ok to confirm the settings and exit the System Configuration Product List 
window.

Removing Products from the Selected Products List
To remove products from an existing Selected Products list:

1. Select Edit > System Configuration Product List. The System Configuration Product 
List window appears.

2. From the Selected Products list, choose the product you want to remove.

3. Click the left arrow (<).

To remove all products from the Selected Products list, click the double left arrow (<<). 
To remove one product at a time, repeat steps 2 and 3.

4. Click Ok to complete the changes. 

The message System Configuration Settings have been saved appears.

5. Click Ok to save the settings and exit the System Configuration Product List window.

Double left arrow (<<) Removes all products from the Selected Products list and places 
them in the Available Products list

Button Function
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2-8 Oracle Transfer Pricing Online Reference Guide



Pro
3

Products

From the main tree in TPOL, you, as the system administrator, choose one product at a time 
to define the product’s characteristics. Once you select a product, the Product Properties 
screen appears. There are three tabbed pages on the Product Properties screen: Pricing 
Assumptions, Main, and Terms.

For each product in the product list, you must define all characteristics that impact the 
calculation of transfer rates.

A detailed explanation of the input requirements for each Product Properties tab follows.
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Pricing Assumptions Tab
Pricing Assumptions Tab
The Pricing Assumptions tab enables you to view basic calculation assumptions for the 
individual products, such as the transfer pricing method and the transfer pricing interest rate 
code used. Also shown is the transfer-pricing spread, which is applicable only for two 
transfer pricing methods: Spread From Note Rate, and Spread From Interest Rate Code. The 
Pricing Assumptions tab also indicates whether or not prepayment assumptions have been 
defined for the product. 

The following fields are read-only. Information from the Transfer Pricing ID and 
Prepayment ID, selected in the System Configuration Settings, is the source of information 
displayed in these fields. 

Pricing Assumption Description

Transfer Pricing Method This is the transfer pricing method defined in the Transfer Pricing ID. 
All transfer pricing methods available in Oracle Transfer Pricing are 
available in Oracle Transfer Pricing Online through the Transfer 
Pricing ID.

If the value for this field is <Undefined>, then no method has been 
assigned to that product in the Transfer Pricing ID within Oracle 
Transfer Pricing.

Refer to the Oracle Transfer Pricing Reference Guide for more 
information on transfer pricing methods.

Transfer Pricing Interest 
Rate Code

This is the interest rate code defined in the Transfer Pricing ID.

If the Transfer Pricing Method chosen is Spread from Note Rate, then 
the value for Transfer Pricing IRC is set to <Not Applicable>.

Refer to the Oracle Transfer Pricing Reference Guide for more 
information on transfer pricing interest rate codes.

Transfer Pricing Spread This is a fixed spread from the note rate or the rate on the transfer 
pricing yield curve.

This spread appears for only two transfer pricing methods: Spread from 
Interest Rate Code and Spread from Note Rate. For all other methods, 
the value is set to <Not Applicable>.

Prepayment Assumptions Assumptions made on the unscheduled reduction of the principal 
balance of a transaction record. If an assumption is defined for the 
product in the Prepayment ID, then this field displays “Yes.”

The Prepayment ID is the basis for the presence or absence of 
prepayment assumptions. 
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Main Tab
Main Tab
Use the Main tab to select product properties for all main product characteristics.

All fields in the Main tab must be populated. As a reminder, the message A selection is 
required appears in each field. Select an item from the drop-down list for each input value. 
The only field that defaults to zero is Rate Rounding Factor. 
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Main Tab
Main Tab Fields
The Main tab contains the following fields:

Property Description

Amortization Type This determines the method of amortizing principal and interest.

Amortization type options include: 

n Conventional Fixed

n Conventional Adjustable

n Non-Amortizing (default value)

n Level Principal Payments

n User-Defined Amortization Types (created in user-defined 
Payment Patterns)

Adjustable Type This determines the method by which the coupon rate is adjusted on an 
instrument. Adjustable Type code options include:

n Fixed (default value)

n Other Adjustable

n User-Defined Adjustable Types (created in user-defined Repricing 
Patterns)

Accrual Basis This determines how the system calculates interest.

The accrual basis options include:

n 30/360

n Actual/360

n Actual/Actual (default value)

n 30/365

n 30/Actual

n Actual/365

Compounding Basis This determines how the system will compound interest payments. The 
compounding basis options include:

n Daily

n Monthly

n Quarterly

n Semiannual

n Annual

n Simple (default value)
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Main Tab
Main Tab Control Buttons
There are two control buttons in the Main tab: 

Interest Payment Timing This determines the timing of an instrument’s interest payments. 

Interest payment timing options include: 

n In  Arrears (default value)

n In Advance 

For conventionally amortized instruments the interest payment timing 
is always In Arrears.

Rate Rounding Type This determines how the system will round the rate assigned to the 
product. The rounding type options include: 

n No Rounding (default value)

n Truncate

n Round to the Nearest Higher Multiple of

n Round to the Nearest Lower Multiple of

n Round to the Nearest Multiple of 

Rate Rounding Factor This determines the precision of the rounding, based on the rate 
rounding type. 

The range of values for the rate rounding factor is 0.0000 (the default 
value) to 9.9999. 

Control Button Function

Reset The Reset button is active when there is at least one product definition 
saved in a database. Click it to clear the changes you made to this tab 
and restore the last saved values.

Set Defaults The Set Defaults button sets the system default values (described in the 
preceding table) for every field in the Main tab.

Property Description
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Terms Tab
Terms Tab
Use the Terms tab to define key terms and additional attributes for each instrument record 
defined per product. These include term-related cash flow characteristics as well as 
attributes determining how the current net rate is to be set.

Key Terms Combination
A key terms combination consists of original term, payment frequency, and repricing 
frequency. 

You can add multiple sets of key terms for a single product, but each key term combination 
must be unique. If any combinations are not unique, the following messages appear when 
attempting to save the product characteristics:

Duplicate record is found for this product. Change the values of one or more key terms 
to make a unique record.

Record: X

and 

Cannot Save Product Definition
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Terms Tab
If these messages appear, change one or more of the existing term values to create a unique 
record and save the product characteristics.

The term definitions and their input requirements are as follows:

Additional Attributes
Whenever you define key term combinations, you must also define attributes such as the 
amortization term and the parameters needed to define current note rate on an instrument 
record. The attributes need not be unique. The message A selection is required appears in 
each field that needs a valid selection.

Term Definition Requirements

Original Term Each original term definition requires the input of a number greater 
than zero, and a multiplier selected from the drop-down list. 

The multiplier options are Days, Months, and Years. The default 
original term to maturity is 1 Months.

Payment Frequency Each payment frequency definition requires the input of a number 
greater than zero, and a multiplier selected from the drop-down list. 
The payment frequency must be less than or equal to the original term.

The multiplier options are Days, Months, and Years. The default 
payment frequency is 1 Months.

Repricing Frequency Each repricing frequency definition requires the input of a number 
greater than zero, and a multiplier selected from the drop-down list.

The multiplier options are Days, Months, and Years. The default 
repricing frequency is 1 Months.

The repricing frequency must be less than or equal to the original term. 
If the Adjustable Type code is anything other than Adjustable, this 
becomes a read-only field and the displayed value is 0 Months.

Attribute Description

Amortization Term The administrator must define an amortization term for each 
combination of key terms. 

The multiplier options are Days, Months, and Years. The default for the 
amortization term is the same as the default for the original term: 1 
Months.

The amortization term must be greater than or equal to the original 
term. If the Amortization Type code is Non-Amortizing, this becomes a 
read-only field and the displayed value is 0 Months.
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Terms Tab
Interest Rate Code The input in this field determines the IRC that will be used with margin 
to define the note rate on the record. 

The default is the first IRC listed in the alphabetized drop-down list.

Margin The margin defines the spread added to or subtracted from the rate 
derived from the IRC. 

The valid range of margin values is –99.9999 to 99.9999. The default 
value is 0.0000.

Rate Set Lag The Rate Set Lag defines a lag period for the interest rate lookup date. 
Each rate set lag requires the input of a number greater than zero, and a 
multiplier selected from the drop-down list.

The multiplier options are Days, Months, and Years. The default value 
is 0 Months.

Tease Period Use of this field is optional. If you include a tease period for an 
adjustable rate instrument, then input a number greater than zero for 
the tease period definition and select a multiplier from the drop-down 
list. 

The multiplier options are Days, Months, and Years. The default value 
is 0 Months.

If the Adjustable Type code is anything other than Adjustable, this 
becomes a read-only field. 

Tease Discount Enter a tease discount value when you define a nonzero tease period. 
The value will be subtracted from the rate calculated using Interest 
Rate Code value plus margin to determine the note rate. 

The tease discount value has a valid range from –99.9999 to 99.9999. 
The default value for a tease discount is 0.0000.

If the Adjustable Type code is anything other than Adjustable, then this 
field becomes read-only. 

Attribute Description
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Defining Product Characteristics
Terms Tab Control Buttons
The Terms tab contains five control buttons:

Defining Product Characteristics
To define characteristics for a given product, complete the following steps:

1. From the Products tree, choose a product. The Pricing Assumptions tab appears. 
Displayed are all of the Pricing Assumptions previously defined in the System 
Configuration Settings interface.

2. Click the Main tab.

3. Where applicable, select the product’s properties, as outlined in the Main Tab section of 
this chapter. 

4. Click the Terms tab.

Control Button Function

Delete Record The Delete Record button deletes the record displayed on the tab, 
unless it is the only defined record. The system deactivates this button 
if there are no records, or if only one record is defined.

Reset The Reset button restores the changes made on the Terms tab to the last 
saved values. 

Set Defaults The Set Defaults button resets the default values for each field, as 
follows:

n Original Term, Payment Frequency, Repricing Frequency and 
Amortization Term equals either 0 or 1 Months. This default 
varies based on dependencies from the Main tab. 

For example: if the Amortization type is Non-Amortizing, then 
the Amortization Term will be 0 Months.

n Interest Rate Code equals The first IRC listed in the alphabetized 
drop-down list.

n Margin equals 0.0000

n Rate Set Lag and Tease Period equals 0 Months

n Tease Discount equals 0.0000

Left Arrow (<) The left arrow button moves the cursor to the previous record. 

Right Arrow (>) The right arrow button moves the cursor to the next record, or enables 
you to create a new record for the current product.
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Creating a New Instrument Record
5. Where applicable, define the key terms and any additional attributes, as outlined in the 
Terms Tab section of this chapter.

6. From the File menu, choose Save.

7. Repeat steps 1 through 6 for each product you want to define.

Creating a New Instrument Record
1. From the Terms tab, click the right arrow button (>) to move to the next record.

2. Input the values for the Key Terms and the Additional Attributes as described earlier in 
this chapter. Remember that the Key Terms combination must be unique to each 
product. 

3. Repeat steps 1 and 2 for each record you want to add to the product definition.

Note: The record counter (to the left of the arrow button) indicates 
whether you are moving to a new record or to the next record. The record 
count format is m of n, where n indicates the number of saved instrument 
records for the current product, and m indicates the currently displayed 
record number. If m > n, then you are at the new record.

For example, if the record count was 1 of 1, then clicking the (>) button 
will change it to 2 of 1. This means that you are at the new (second) record 
while there is only 1 record saved for this product.
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Scheduler

Scheduling transfer pricing calculations is an administrative function. Using the Scheduler, 
you can designate transfer rates calculations to be run automatically at certain intervals, or to 
be run once at a specific time. If an error occurs during a calculation run, then the system 
displays a message in the Message Viewer. 

The Scheduler and the Message Viewer appear as tabbed pages in the Scheduler screen. The 
first part of this chapter explains how to use the Scheduler tab, and the second part discusses 
the Message Viewer.
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Scheduler Tab
Scheduler Tab
Enter the calculation run parameters in the Scheduler tab. You can schedule only one job at a 
time, whether it is a single event or is to recur on a specific basis. 

The Scheduler tab fields and the input they require are as follows:

Field Description

Job Type This is a read-only field. The Job Type defaults to TPOL Calculations.

Last Calculation Run This is a read-only field. It enables you to review the last time the 
scheduled transfer pricing calculation process ran.

Schedule A check mark in the Schedule box means that you want to schedule a 
job. Click the box to place a check mark, and click again to remove it. 

When the Schedule box is empty the Run Once, Run Every, and Next 
Calculation Run fields are disabled. No jobs will run until you schedule 
them. 
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Scheduler Tab
Scheduling a Calculation Run
To schedule a TPOL calculation run, complete the following steps:

1. From the Tools menu, select Schedule. The Scheduler screen appears.

2. If a check mark is not visible, click Schedule once.

3. Specify whether to run a job once or periodically:

a. To run a job once, select Run Once.

b. To run a job periodically, enter a value in the Run Every field, and select a 
multiplier from the drop-down list.

4. In the Next Calculation Run field, enter the date and time you want to run the transfer 
pricing calculation process. Use the following date format: mm/dd/yyyy. Use this time 
format: hh:mi PM. (Be sure to select either AM or PM.)

5. Select Submit to save your definitions. To discard the changes you made and reset the 
scheduler to the last saved values, select Cancel.

Run Once Click this box to schedule a single, nonrecurring transfer pricing 
calculation process. Click again to unschedule.

When the Run Once box is checked, the Run Every field is disabled. 
After the job specified in the Next Calculation Run field is processed, 
no jobs will run until you schedule them again.

Run Every Defines the frequency with which a scheduled transfer pricing 
calculation process occurs, unless you choose the Run Once option. 

In the first input area, enter a number greater than 0. In the second 
input area, use the drop-down list to select a multiplier. The multiplier 
options are Days, Months, and Weeks.

When you adjust the frequency, the next scheduled calculation date is 
not effected. After the process runs on the initial date, the system 
schedules the subsequent calculation date based on the new frequency. 

Next Calculation Run The Next Calculation Run date determines when the scheduled transfer 
pricing calculation process next runs. The next scheduled calculation 
date automatically updates each time a run occurs. You can also adjust 
the date and time to any date and time in the future (including the 
current date). 

Field Description
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Message Viewer Tab
Unscheduling a Calculation Run
To unschedule an existing scheduled run, do the following:

1. Select Tools > Schedule. 

The Scheduler screen appears.

2. Click the schedule box one time to remove the checkmark.

3. Click the Submit button to save your definitions. If you choose to discard the changes 
you have made and reset the scheduler to the last saved values, click the Cancel button.

Message Viewer Tab
The Message Viewer tab displays any warnings and error messages generated during the 
calculation process. 
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Message Viewer Tab
The Message Viewer tab columns are as follows:

There is also a Refresh button on the Message Viewer. Click this button to display the most 
current information. If any calculation process runs while you have the viewer open, the 
Refresh button will update the viewer with the errors (if any) of that process.

Column Description

ID Number Errors and warnings generated by Oracle Transfer Pricing have 
individual proxy record ID numbers, which display for each product 
record. Errors and warnings generated by TPOL-related processing 
have an ID number of -1. 

Error Date Listed in this column are the dates and time on which the calculation 
run errors occurred.

Error Code TPOL uses the same set of error codes as Transfer Pricing, plus 
additional codes used in other OFSA processing.

For information about TPOL error codes, see Appendix A. For more 
information on Transfer Pricing error codes, refer to the Oracle 
Transfer Pricing Reference Guide and the Oracle Financial Services 
Technical Reference Manual. 

Error Description Listed in this column is a description of the processing error or 
warning.

Context This column displays additional information about the condition 
referenced in the Error Description column.
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Queries

After TPOL performs a transfer rate calculation run, it stores the results in the database. The 
Query function enables you to retrieve this information and view it in a report produced in a 
separate browser window. You can save the results if you want. However, you can reopen 
only those queries that were created and saved under your user name. 

Defining a Query
Define your query in the Query window.
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Defining a Query
The following table describes the input required in the Query window:

Field or Section Description

Query Name The system automatically generates a query name, which you can 
edit. For example, you can enter a name that you find more 
descriptive of the query contents.

Description If you want, enter a brief description of the nature of the query. 
(This is an optional field.) 

Select a Date Range The date range you select determines the scope of the query. The 
options in this field are: 

n Current Date

n Last Month

n Last 3 Months

n Last 6 Months

n Last Year

n Last 3 Years

n Last 5 Years

n All

n Specific Date Range (if you select this, then input a From date 
and a To date) 

Select One or More Products The list of available products displays products for which there are 
calculated transfer rates (under the active Product Dimension 
defined by the administrator). Select one or more products to be 
included in the report, or select all products if you want. You can 
edit the product list and rerun the query if necessary. 

Click the left arrow button (<) or the right arrow button (>) to move 
one product selection at a time between the Available column and 
the Selected column. To move all products in a column into the 
other column, click a double arrow button (<<) or (>>).
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Query Report
Query Report
These columns appear on the generated query report: 

n Product Name

n Date

n Transfer Rate

n Original Term

n Payment Frequency

n Repricing Frequency.

In the report, data is sorted first by product name and then by process date. 
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Creating a New Query
Creating a New Query
To generate a new query, complete the following steps: 

1. From the File menu, choose New > Query.

2. Click the Name field to highlight the system-generated query name, and enter a new 
name. 

3. From the drop-down list, choose a date range. 

The From and To dates are automatically displayed, unless you select Specific Date 
Range. In that case, enter a date in the From field and the To field.

4. From the Available products list, use the arrow keys to move products to a Selected 
products list. 

5. From the Tools menu, choose Run. 

The report appears in a separate browser window. Use your browser to print the report, 
save it, or both.

Note: This field is optional. If you plan to save the query, it is a good 
idea to enter a query name. You can also enter a query description in the 
corresponding field.
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Worksheets

Using TPOL Worksheets you can generate cash flows and calculate transfer rates 
based on the input of instrument cash flow and payment characteristics in real time. 
Worksheets can be used to generate transfer rate indictions for nonstandard, custom 
transactions that have not been included in standard products accessible with 
queries.

Once you create a worksheet, you can save it for future use, rather than 
regenerating a new one with the same characteristics.

Worksheet Methods
There are two methods of using Worksheets to calculate transfer rates. One method 
is to input instrument properties and terms, and the other is to define a payment 
schedule with specific dates and amounts in addition to relevant instrument 
properties. For the former method, you use the Input Characteristics worksheet, 
and for the latter you use the Input Payments worksheet. The default option is 
Input Payments. 
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Worksheet Methods
Depending on the method you choose, TPOL displays either two or three tabs. If 
you choose Input Payments, all three tabs appear: Main, Terms, and Payments. If 
you choose Input Characteristics, only the Main and Terms tabs appear.

Method Description

Input Payments Used to define instrument characteristics including specific 
payment dates and amounts. 

Input Characteristics Used to define instrument properties and term combinations 
(such as Original Term and Payment Frequency).
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Main Tab
Main Tab
Whether you choose Input Payments or Input Characteristics, the Main tab appears.

In the Main tab, enter all information required for transfer pricing calculations. 
Select a value and enter a starting date for each selectable field. This rule applies 
regardless of your chosen input method. 
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Main Tab
Main Tab Fields
When you open a new worksheet dialog for the first time, the message A selection is 
required appears in all fields requiring a selection. The following fields require input:

Property Description

Process Date If the worksheet is new, the current date appears as the Process 
Date by default. If the worksheet was previously created and 
saved, then the stored process date is displayed. 

If you want to run an existing Input Payments worksheet with a 
new process date, then be sure that all of your payments match 
the new date.

Amortization Type or 
Payment Type

When you choose the Input Payments option, these items 
becomes available for selection:

■ Conventional Fixed (default value)

■ Conventional Adjustable

■ Level Principal Payment

An additional item, Non-Amortizing, becomes available when 
you choose the Input Characteristics option.

When entering payment amounts in the spreadsheet, you must 
input an amount appropriate for the payment type. For example, 
conventional payments require you to enter the full payment 
amount, including principal and interest. Level Principal 
payment types require that you enter only the principal portion 
of the payment, and the system will calculate the interest portion 
of the payment at run-time.

Adjustable Type This property determines the method by which you adjust the 
coupon rate for the instrument.

Adjustable type code options include:

■ Fixed Rate (default value)

■ Other Adjustable

■ (All user-defined adjustable type codes created with 
user-defined repricing patterns in Oracle Transfer Pricing).
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Main Tab
Accrual Basis This property determines how the system calculates interest. The 
accrual basis options are:

■ 30/360

■ Actual/360

■ Actual/Actual (default value)

■ 30/365

■ 30/Actual

■ Actual/365

Compounding Basis This property determines how the system will compound 
interest payments. The compounding basis options include:

■ Daily

■ Monthly

■ Quarterly

■ Semi Annual

■ Annual

■ Simple (default value).

Interest Payment Timing This property determines the timing of an instrument’s interest 
payments. The options are In Arrears (the default value), and In 
Advance.

For conventionally amortized instruments the interest payment 
timing is always In Arrears.

Rate Rounding Type This property determines how the system will round the rate 
assigned to the product, if appropriate. The rounding type 
options are: 

■ No Rounding (default value)

■ Truncate

■ Round to the Nearest Higher Multiple of

■ Round to the Nearest Lower Multiple of

■ Round to the Nearest Multiple of

Rate Rounding Factor This property determines the precision of the rounding, based 
on the rate rounding type. 

The range of values is 0.0000 (the default value) to 9.9999.

Starting Balance The starting balance is the instrument or transaction balance at 
origination. The default value is 0.00.

Property Description
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Main Tab
Main Tab Control Buttons
The Main tab has two control buttons: Reset, and Set Defaults. 

Reset
The Reset button restores the changes made on the tab to the last saved values. 

Set Defaults
The Set Defaults button resets the default values for each field, as follows:

Field Default Value

Amortization Type/Payment Type Conventional Fixed

Adjustable Type Fixed Rate

Accrual Basis Actual/Actual

Compounding Basis Simple

Interest Payment Timing In Arrears

Rate Rounding Type No Rounding

Rate Rounding Factor 0.0000

Starting Balance 0.00
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Terms Tab
Terms Tab
In the Terms tab, as in the Main tab, attribute definitions must be completed for 
both the Input Payments and Input Characteristics methods. The following fields 
are inactive for the Input Payments worksheet: Original Term, Amortization Term, 
and Payment Frequency. Data for these fields is to be entered through the Payments 
tab, described later in this chapter. 

Terms Tab Fields
The following fields require input:

Property Description

Original Term Each Original Term definition requires the input of a number 
greater than zero, and a multiplier selected from the drop-down 
list. 

The multiplier options are Days, Months, and Years. The default 
is 1 Months.

On the Input Payments type of worksheets, the system disables 
the Original Term field.
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Terms Tab
Amortization Term Each Amortization Term definition requires the input of a 
number greater than zero, and a multiplier selected from the 
drop-down list. 

The multiplier options are Days, Months, and Years. The default 
value is 1 Months.

The Amortization Term must be greater than zero, and greater 
than or equal to the Original Term. If the Amortization Type 
code is “Non-Amortizing,” this becomes a read-only field and 
the displayed value is 0 Months.

On the Input Payments type of worksheets, the system disables 
the Amortization Term field.

Payment Frequency Each Payment Frequency definition requires you to input a 
number greater than zero, and a multiplier selected from the 
drop-down list. 

The multiplier options are Days, Months, and Years. The default 
value is 1 Months. 

The Payment Frequency must be less than or equal to the 
Original Term. 

On the Input Payments type of worksheets, the system disables 
the Payment Frequency field.

Repricing Frequency Each Repricing Frequency definition requires the input of a 
number greater than zero, and a multiplier selected from the 
drop-down list. 

The three multiplier options are Days, Months, and Years. The 
default repricing frequency is 1 Months.

The Repricing Frequency must be less than or equal to the 
Original Term. If the Adjustable Type field value in the Main tab 
is anything other than “Adjustable,” this field becomes 
read-only and the displayed value is 0 Months.

Interest Rate Code The input in this field determines the Interest Rate Code (IRC) 
which will be used to define your note rate on the instrument. 

The default is the first IRC listed in the alphabetized drop-down 
list.

Margin The Margin defines the additional spread added to (or 
subtracted from) the rate derived from the IRC.

The valid range is –99.9999 to 99.9999. The default value is 
0.0000. 

Property Description
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Terms Tab
Rate Set Lag The Rate Set Lag defines a lag period for the interest rate lookup 
date. Each Rate Set Lag requires the input of a number greater 
than zero, and a multiplier selected from the drop-down list. 

The multiplier options are Days, Months, and Years. The default 
value is 0 Months.

Tease Period Use of this field is optional. If you choose to include a Tease 
Period, then the Tease Period definition requires you to input a 
number greater than zero, and a multiplier selected from the 
drop-down list. 

The multiplier options are Days, Months, and Years. The default 
value 0 Months. 

If the value in the Adjustable Type field (in the Main tab) is 
anything other than “Adjustable,” the Tease Period field 
becomes read-only. 

Tease Discount Enter a Tease Discount value whenever you define a nonzero 
tease period. 

The tease discount value has a valid range from –99.9999 to 
99.9999. The default value is 0.0000

The value entered will be subtracted from the rate derived using 
the Interest Rate Code plus Margin to produce the note rate for 
the Tease Period.

If the Adjustable Type field value in the Main tab is anything 
other than “Adjustable,” this becomes a read-only field. 

Property Description
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Terms Tab
Terms Tab Control Buttons
The Terms tab has two control buttons: Reset, and Set Defaults.

Reset
The Reset button restores the changes made on the tab to the last saved values. 

Set Defaults
The Set Defaults button resets the default values for each field, as follows:

Field Default Value

Original Term, Amortization Term, Payment 
Frequency, and Repricing Frequency

Either 0 Months or 1 Months, depending on 
your selections in the Main tab. 

For example, if the Amortization type is 
nonamortizing, then the Amortizing Term 
will be 0 Months. Otherwise Amortization 
Term will be set to 1 Months.

Interest Rate Code (IRC) The first IRC in the alphabetized list

Margin 0.0000

Rate Set Lag and Tease Period 0 Months

Tease Discount 0.0000
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Payments Tab
Payments Tab
The Payment tab appears when you use the Input Payments worksheet method. It 
contains two sections: 

■ Automatic Date and Payment Generation

■ Define Payment Dates and Amounts

To define a payment schedule, you can either manually input payment dates and 
amounts into the corresponding columns of the spreadsheet, or you can use the 
automatic date and payment generation tool for this purpose. For more information 
about creating a spreadsheet see “Creating a Worksheet,” later in this chapter.
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Payments Tab
Payments Tab Fields
Define payment dates and amounts in the Payments tab as follows:

Property Description

Start Date The Start Date is the date of the first payment you want to 
generate. If the Interest Payment Timing (selected in the Main 
tab) is In Advance, then the Start Date must be at least equal to 
the Process Date, or higher. If the Interest Payment Timing is in 
Arrears, then the Start Date must be at least Process Date + 1 
day, or higher. 

The default value is the same as the Process Date.

Increment By This property consists of two fields, which represent the 
frequency of the generated payments. Each Increment By 
requires the input of a number greater than zero, and a 
multiplier selected from the drop-down list. 

The multiplier options are Days, Months, and Years. The default 
value is 1 Months.

Number of Payments Enter a number greater than zero for the total number of 
payments you want to generate. The default value is 1.

Start Payment This is the first payment amount generated at the Start Date. 

Increment Type This indicates the type of the payment increments to be 
generated for each subsequent payment. The Increment Type 
options are:

■ Constant (default value)

■ Increment by Value

■ Increment by Percentage.

Increment Amount This is the amount of increment for each subsequent payment. 
This field requires the input of a number greater than or equal to 
zero. The interpretation of the value is:

■ The absolute increment value (in $$) if the Increment by 
Value type is selected. For example, a value 10 in this case 
will mean $10 increment for each subsequent payment.

■ The percentage value (in %) if the Increment by Percentage 
is selected. For example, a value 10 in this case will mean 
10% of increment for each subsequent payment.

This field does not have a default value.
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Payments Tab
Payments Tab Control Buttons
There are five control buttons in the Payments tab: one in the Automatic Date and 
Payment Generation section, and four in the section titled Define Payment Dates 
and Amounts. The functions of the buttons are:

Date Enter the date for each payment in a valid date format (such as 
MM/DD/YYYY). Each date must be unique and greater than or 
equal to the Process date. If the Interest Payment Timing is In 
Arrears, then the date equal to the Process Date will be ignored 
in the calculations.

Payment Enter the payment amount of each payment in a currency 
format. The number must be greater than zero and have no more 
than two decimal places.

Control Button Function

Generate Generates payments as specified in the Automatic Date and 
Payment Generation section of the screen, and enters them into 
the Payment Dates and Amounts spreadsheet.

Sort Sorts the dates on the Payments tab in chronological order (from 
the earliest date to the latest). The system also sorts dates 
automatically when the worksheet is saved. 

Clear Clears all information from the row where the cursor is placed.

Clear All Clears the entire spreadsheet in the Define Payment Dates and 
Amounts section of the screen. A Worksheet Definition warning 
appears, asking you to confirm the deletion.

Reset All Discards any modifications made to the spreadsheet in the 
Define Payment Dates and Amounts section, and restores the 
latest saved values. A Worksheet Definition warning appears, 
asking you to confirm your decision.

Property Description
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Creating a Worksheet
Creating a Worksheet
To create a new worksheet:

1. From the File menu, choose New > Worksheet.

2. From the drop-down list on the Worksheet Definition screen, choose either 
Input Payments or Input Characteristics. Click OK. The worksheet screen 
appears with a system-generated name. You can:

a. Click in the Worksheet name field and enter a worksheet name, and click in 
the Description field to enter a description, or

b. Leave the worksheet name and description as it appears and proceed to 
step 3.

3. On the Main tab, the Process Date shown is the default current date. If you 
would like to change this date, click the Process Date field and enter a new 
process date, otherwise, proceed to step 4.

4. Select the instrument properties, as outlined in the Main Tab section of this 
chapter.

5. Upon completion of the input requirement for the Main Tab, click the Terms tab. 
The Terms tab screen appears.

6. Define all other attributes as required.

7. If you selected Input Payments in the Worksheet Definition screen, click the 
Payments tab. Otherwise, go to step 9.

8. Input payment dates and amounts to define the payment schedule:

a. Enter a date using one of these formats: MM/DD/YYYY or MMDDYY. 
Then press [Tab] or [Enter].

b. Enter a payment amount. Use positive whole numbers with a maximum of 
two decimal places.

c. Press the down arrow key to go to the next date or payment cell. When the 
last row is filled, you can add new rows by pressing the down arrow key.

Note: You can use the Automatic Date and Payment Generation 
tool to input payment information automatically. See “Using the 
Automatic Date and Payment Generation Tool,” following this 
procedure.
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Creating a Worksheet
9. From the File menu, choose Save to save the worksheet.

Using the Automatic Date and Payment Generation Tool
When creating a worksheet, you can generate payment data automatically by using 
the Automatic Date and Payment Generation tool.

1. In the Start Date field, enter the first payment date. The default start date is the 
Process Date.

2. In the Increment By field, enter the frequency of payments to be generated. 
Input a number greater than 0, then select a multiplier from the drop-down list. 
There are three multiplier options: Days, Months, and Years. The default value 
is 1 Months.

3. In the Number of Payments field, enter the total number of payments over the 
life of the instrument. This number must be greater than 0, and the default 
value is 1.

4. In the Start Payment field, enter the first payment amount. The default amount 
is 0.00.

5. In the Increment Type field, enter the type of payment increment. There are 
three multiplier options: Constant, Increment by Value, and Increment by 
Percentage. The default option is Constant.

6. In the Increment Amount field, enter the amount of payment increment in 
absolute value for the Increment by Value type, or a percentage for the 
Increment by Percentage type. By default, this field is disabled when the 
increment type is Constant.

7. Click Generate to generate the payment records that you specified. 

8. View the Payments grid, and enter any modifications or/and additional 
records.

Note: Enter the percentage in whole number format. For example, 
to indicate 10% enter 10.0.
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Running a Calculation
Saving a Worksheet
You can save a worksheet at any time during the input process. The system 
automatically places dates in chronological order.

To save a worksheet:

1. Select File > Save. 

A message appears, confirming that the worksheet has been saved. 

2. Click OK.

Running a Calculation
Use the Run option to calculate transfer rates for any products you have previously 
defined using a worksheet. To run a calculation, complete the following steps:

1. From the product tree, open the worksheet hierarchy and choose a worksheet.

2. From the Tools menu, choose Run. 
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Running a Calculation
When the run is finished, TPOL displays the calculated transfer rate along with the 
following data:

■ Worksheet name

■ Process date

■ Transfer rate

■ Last payment

■ Cash flow date

■ Principal cash flow

■ Interest cash flow

■ Runoff rate

■ Repricing balance

■ Repricing rate

For fixed rate instruments, principal and interest cash flows to maturity and the 
corresponding runoff rate are displayed. For adjustable rate instruments, principal 
and interest cash flows (and the runoff rate) until the first repricing date are 
displayed, at which point the repricing balance and repricing rate are also 
displayed.
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Running a Calculation
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Error Mess
A

Error Messages

While running Worksheets, TPOL generates one or more of the following messages 
when errors are detected:

OFSA-110 No match for Interest Rate Code %ld. 
The IRC specified does not exist.  The transfer pricing process needed the specified inter-
est rate, but the corresponding code does not exist in OFSA_IRCS. 

OFSA-122 Historical rates not found. 
An error occurred loading the historical rates table.  Error message OFSA-110 should 
indicate the problem. 

OFSA-115 No data for Interest Rate Code %ld. 
The specified IRC has no data defined.  No historical data exists in OFSA_IRC_RATE_
HIST for the process date or prior to the process date. 

OFSA-555 No schedule found for record. 
The AMRT_TYPE_CD specified indicates a schedule is to be used, but none was pro-
vided. 

OFSA-560 Payment pattern data can not be found for AMRT_TYPE:%i 
Specified payment pattern does not exist. 

OFSA-590 Invalid pattern_type_cd (%hd) for repricing pattern %ld. 
User defined repricing pattern is corrupted.  Recreate specified pattern. 

OFSA-600 Repricing pattern %ld not found. 
The specified Repricing Pattern does not exist or contains no events. 

OFSA-1001 Adjustable type code %hd not supported for Transfer Pricing Online. 
TPOL does not support adjustable types 30 and 50.  Should not occur in TPOL. 

OFSA-1003 Invalid repricing pattern %ld: no rate provided for flat rate. 
Repricing pattern has an event specifying a flat rate, but no rate is provided.  Fix the 
repricing pattern. 
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OFSA-1004 No transfer pricing method defined for product %.0lf. 
Seeded TP Id for worksheets does not define a TP method for the default product used 
for TPOL.  Have administrator set up TP worksheets. Should not occur in TPOL.

OFSA-53000 Instrument record is in an invalid format. 
The instrument information was not correctly transmitted to the transfer pricing calcu-
lation module.  Verify that the LD_LIBRARY_PATH environment variable in the 
Forms startup script points to the correct OFSA installation. 

OFSA-53001 Payment schedule is in an invalid format. 
The payment schedule information passed to the transfer pricing calculation module 
could not be parsed.  Verify that the LD_LIBRARY_PATH environment variable in the 
Forms startup script points to the correct OFSA installation. 

OFSA-53002 No Transfer Pricing or option calculation defined in Process ID: %d 
The seeded Transfer Pricing ID does not indicate any calculations.  Verify that the 
TRANS_RATE_CALC_FLG column of OFSA_IDT_TP_PROCESS for the seeded 
transfer pricing ID is 1. Should not occur in TPOL.

OFSA-53003 Payment Schedules not supported for Amortization Type Code: %d 
Payment Schedules may not be used in conjunction with user defined payment pat-
terns or Rule of 78s.  Do not specify a payment schedule when specifying a user defined 
payment pattern. 

OFSA-53004 Payment Schedules must start on or after process date and end after 
process date. 
The specified payment schedule has its first payment date before the current process date 
or its last payment is not after the process date. 

OFSA-53005 Term of instrument must be greater than 0. 
Term of instrument must be greater than zero. Should not occur in TPOL.

OFSA-53006 Instrument balance must be greater than 0. 
Instrument must have a starting balance greater than zero. Should not occur in TPOL.

OFSA-53007 Repricing Event has no Interest Rate Code specified.  User defined 
repricing code: %d 
The initial event in a user defined repricing code indicates an Indexed Rate is to be used 
but no Interest Rate Code is provided.
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